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Introduction 
E-Z Data’s Group Benefits Module (GBM) for Client Data System (CDS) provides the user with 
powerful and flexible group policy tracking features. With the GBM, the user can: 

• Track detailed information regarding a client’s group coverage from the individual client 
record or business record. 

• Run proactive prospecting campaigns with queries for clients who lack a specific type of 
coverage. 

• Quickly and easily display a summary of all coverage for one client or multiple clients. 

• Track a client’s individual and group coverage in the same portfolio. 

• Track multiple plans under each group product. 

• Track key employees of group business clients for individual business marketing campaigns. 

• Run Crystal Reports™ designed specifically for Group Benefits Tracking, which include 
Summary Reports, Detail Reports and Benefits Reports. 

• Add and customize new categories of benefits for each product type. 

• Generate and customize Dynamic Reports™, Census Reports, Summary Reports and much 
more. 

GBM is a dynamic module that interacts seamlessly with standard CDS client management tools. 
Use GBM with CDS to track all of your individual and group business, regardless of size, and to 
provide your clients with the highest level of service. 
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Agent/Producer and Vendor Records 
Agent/Producer and Vendor records must be created before adding group products or using the 
GBM features. If these types of records have already been created, continue with the next topic, 
Adding Group Products. For information about creating Agent/Producer and Vendor records, 
refer to the CDS online help.  

Adding Group Products 
1. From the CDS desktop, open the File menu and then select Group Product. 

2. When the Find Group Product Detail dialog box opens, click OK to open the Group Product 
Summary tab. 

3. Click the Add Record button to open the Group Product Detail tab in add mode. 

4. When the Group Product Detail tab opens: 
a. Enter the product name and code. 

b. Select the Group Insurance Type from the drop-down list. 

c. Select the Carrier from the drop-down list (click the Carrier field name button to find or 
add a new carrier). 

d. Select an Illustration Program from the drop-down list (click the Illus. Program field 
name button to find an illustration program or to add one to the list). 

e. Click the Save button after adding the Product Information. 

 
5. Select the Plan Summary tab. (Retirement and Travel products do not have a Plan 

Summary tab.) 
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6. Click the Add Record button on the Plan Summary tab to open the Add Plan dialog box. 

 
7. Enter the Plan Name and then click OK. 

8. Repeat Steps 6 and 7 to add more Plan Names. 

Group Product Tabs 
Every group product record includes summary and detail tabs, and a Group Policies tab that lists 
all group policies for each product. When group product records are created, additional tabs for 
specific information about the product are added. The type and number of tabs that will be added 
depends upon the type of insurance. 

General Tabs 
General tabs are added to each group product record when it is created. Except for medical-type 
insurance products, General tabs have predefined data categories for storing information about 
the benefits, deductibles, and limitations of the product-related plans listed on the Plan Summary 
tab. Benefit and plan information tabs for Retirement and Travel types of group products are 
located at the Group Policy level. 

Choice Options can be added to the alphanumeric fields of these General tabs for efficient and 
consistent data entry (refer to the CDS online help for detailed information about Choice 
Options). 
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User-Defined Tabs (All Insurance Types) 
User-defined tabs can be added to each type of group insurance. These tabs are in spreadsheet 
format to accommodate the categorization of a wide variety of features and options associated 
with group insurance product plans. When tabs are added to one type of insurance, the tabs 
appear in all products of the same insurance type.  

User-Defined Tabs (Medical Insurance) 
When a database is created, six user-definable tabs with predefined options are created as default 
tabs for medical-type insurance products. When a medical insurance product is added to the 
database, these six tabs are automatically added to the product record. After adding a plan to the 
medical insurance product, these six tabs can be changed or deleted, or more user-defined tabs 
can be added (refer to the next section). Any tabs that are changed or added then become the new 
default set of tabs for all existing and new medical-type insurance products. 
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Adding Group Product Tabs 
User-defined tabs are based on the type of insurance, not the insurance product. For example, 
when a tab is added to one life insurance product, the new tab will appear in all life insurance 
product records because the insurance types are the same. 

Adding a Tab 
1. From the CDS desktop, open the File menu and select Group Product. 

2. When the Find Group Product Detail dialog box opens, click OK to open the Group Product 
Summary tab. 

3. Select a product on the summary list and then click the Group Product Detail tab. (The 
selected product insurance type is used as the insurance type for the new tab.) 

4. Select Group Benefit Tabs Setup from the Tools menu.  

5. Click the Add Record button to open the Group Benefit Setup dialog box. 

6. Enter a name for the tab in the Tab Name field. 

7. Enter a number for the relative position of the tab in the Tab Order field. (Refer to Tab 
Positions for setup information.) 

8. Enter a descriptive word or term for the benefit option in the Options field. 

9. Enter a number for the option in the Options Order field. (The Options Order number 
arranges the options in ascending order on the tab. Options Order numbers cannot be repeated 
on the same tab.) 

Tab Positions 
The position of each new tab is relative to the default tabs of the insurance type. For most 
insurance types, the first tab position is next to the General tab. For Retirement and Travel 
insurance, the first tab position is next to the Group Product Detail tab. 

For Medical insurance, the first tab position is next to the Plan Summary tab. The six default 
tabs that are created when the first medical product is added to the database appear in the first six 
tab positions. These tabs can be rearranged, modified, or replaced as needed. 

Using increments of 5 or 10 while entering Tab Order numbers adds flexibility to tab positioning. 
For example, using 5, 10, and 15 to sequentially number three new tabs leaves room for 
additional tabs in any position without having to renumber the original tabs. 
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Defining an Option 
Group insurance options are added to each user-defined tab when the tab is created. After the tab 
is created, other options can be added, and the original options can be modified or deleted. 

For multiple options to appear on one tab, the same Tab Name and the same Tab Order number 
must be used for each additional option. When tab names are identical, but the Tab Order number 
is different, multiple tabs with the same name will be created. 

After options have been added, coverage and exclusions are defined or modified on the tab where 
the option is located. To define the coverage and exclusions for an option: 

1. Open the Group Product Summary tab and select a group product with a user-defined tab. 

2. Click the Plan Summary tab and then select a user-defined tab. 

3. Double-click on the name of an option to open the Group Policy Category dialog box. 

 
4. Add coverage and exclusion details to the fields under In Network, Out of Network, and 

Special/Other and then click OK. 

5. Repeat Steps 3 and 4 to define other options on the current tab and other user-defined tabs. 
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Business Records 
A Business record for each business must be created before Group Census records can be added 
to the database for that business. To access or add business records, click the Business button on 
the CDS toolbar to open the Find Business dialog box. 

Use the Find Business dialog box to search for a specific business or to add a business record to 
the database. For more information about adding Business records, refer to CDS Help or the CDS 
Tutorials.  

 
Business Record Tabs 
The function and design of Business records in CDS is similar to Contact records. Multiple tabs 
are used to categorize stored information, and the different tabs are selected by clicking on them. 
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Summary Tab 
The Summary tab lists the business records that were found in the database, based on the search 
criteria used in the Find Business dialog box. 

Detail Tab 
The Detail tab stores detailed address and phone number information for the business record 
selected on the Summary tab. 

Key Relations Tab 
The Key Relations tab lists Contacts or Group Census members who are linked to the business 
record as a Key Relation. 

Business Custom Fields Tab 
The Business Custom Fields tab contains numerous extra fields that can be customized by the 
user. 

The Group Census Tab 
The Group Census tab lists the names of persons associated with the business who are 
employees, members of a group benefit plan, or both. Add, modify, delete, and track group 
census and benefit plan members from this tab. To change a group census record into a Contact 
record, tag the group census record(s) and click the Convert to Contact button. 

 
Adding a Group Census Member 
Click the Add Record button on the Group Census tab to start the process. There are two 
options when adding a Group Census record: 

Add Group Census for this business from existing contacts 

Select this option and click OK to open the Find Contact Information dialog box. Locate and 
select existing Contact records to add to the group census. When existing Contact records are 
added to the group census for a business, the user is prompted to have the program update the 
business address in the selected Contact records. 
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Create new Group Census Member for this business 

Select this option and click OK to open a blank Group Census record. Enter personal, spouse, and 
miscellaneous information and then click OK to add the record to the group census for the 
business. 

 
Group Census Records 
Group Census records store information about the members. Select a record on the Group 
Census tab and click the Modify button or double-click on the record to open it. Add or modify 
information for the group census member and then click OK to save the changes. 

 
Group Census Records vs. Contact Records 
Group census records are used to track clients that only have group benefits. Contact records are 
used to track clients with individual policies or investments, in addition to their group benefits.  

Group census records do not appear in Contact record search results by default. To include group 
census records in Contact record search results, select the Show Group Census option on the 
Contact Record tab of the User Profile. When search results are displayed, group census records 
appear in blue as they do on the Group Census tab in Business records. 
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Importing Group Census Names 
Group census names can be imported into the database using the Import Census Names option 
to reduce or eliminate manual data entry. The names to be imported must be in a format that is 
compatible with the CDS import utility, such as ASCII, Comma Separated Value (CSV), or 
dBase. Refer to the CDS online help topic Importing and Exporting Data for information about 
supported file formats. 

1. Open the Business record that the census names will be imported to and select the Group 
Census tab. 

2. Select Import Census Names from the Tools menu to open the Import/Export Definitions 
dialog box. 

3. Select an existing import definition or create a new definition to use and then click the 
Import button. 

4. When the Contact/Business Import Options dialog box opens, select the various options to 
apply to the imported records and then click OK. (Click the Help button for specific 
information about each option.) 

 
5. When the Import File Name dialog box opens, locate and select the file that contains the 

group census names and then click Open.  

6. A sample of the import data will be displayed in a window for review. If the appropriate type 
of data populates the columns, click OK to import the names to the Group Census tab. (If 
the sample data does not populate the appropriate columns, you may need to cancel the 
import process and modify the import definition.) 
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Group Policies 
Accessing Group Policies 
Access Group Policies from the Summary, Detail, and Business Custom Fields tabs of a 
Business record by clicking the Group Policy button on the CDS toolbar. 

Access Group Policies from the Contact window by clicking the Policies button, selecting a 
group policy on the Summary tab, and then clicking the Group Policy Details button on the 
window toolbar. (Group policies on the Summary tab of the Contact’s policy portfolio are 
highlighted in yellow.) 

Group Policy Window 
The vertical tabs of the Group Policy window categorize the group policies by insurance type. 
The horizontal tabs categorize the details of each policy. 

Adding Group Policies 
Add, delete, or modify group policies from the Group Policy Summary tab. To open this tab, 
click the Group Policy button from the CDS desktop to open the Find Group Policy dialog box. 
Click OK in the dialog box to open the Group Policy Summary tab. 

Click the Add Record button on the Summary tab to open the Select Policy Type dialog box. 
Select the type of policy to add and then click OK to open the Policy Information tab where 
details for the new policy can be added. 

Policy Information Tab 
The Policy Information tab stores plan information and details about the group policy. This tab 
is the same for all products. Enter or modify information on this tab as you would on any other 
CDS tab and then click the Save button. 
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Adding Plans to a Policy 
After saving the group policy, plans can be added. Click the Add Record button under Plans to 
open the Plans/Classes for the product dialog box. Existing plans can be selected or new plans 
can be added to the list for selection. Tag the plans on the list to be added to the policy and then 
click the OK, Select button.  

Viewing Plan Benefits  
To view the benefits of a group policy plan, select the plan on the Policy Information tab and 
then click the Show Benefits button. When the Plan Summary tab of the product opens, select 
the General tab for the product. 

 
After adding plans to the policy, select one of the plans on the Policy Information tab to access 
the Premium, Custom and Members tabs. Use the navigation arrows from any of these tabs to 
display information about other plans. 

Members Tab 
Group policies have a Members tab that stores information about employee membership in a 
plan (this tab is not accessible until a plan is added to the policy). To add members, click the Add 
Record button.  
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Names that have been added to the Group Census tab of the Business record, but have not been 
added to a group policy plan for the Business are displayed on a Contact list. Tag the records to 
be added to the Members tab and then click the OK, Select button. 

 
When members are added, the group policy record is linked to each member’s personal policy 
portfolio. To view each personal policy portfolio, select a record on the Members tab and click 
the Member Portfolio button. To view a member’s Group Census or Contact record, click the 
Contact button. 

Custom Tab 
The Custom tab provides customizable fields for tracking user-defined information. Field names 
that are customized affect all Custom tabs for the policy type. Data that is entered in these fields 
are specific to the plan selected. Refer to CDS Help for more information about field 
customization. 
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Premium Tab  
The Premium tab is only available for Medical, Dental and Vision policies, and is used to track 
the individual premium totals for employee and family coverage. Premium fields are also located 
on the Policy Information tab for all policy types. 

 

Group Benefits Reports 
There are six Crystal Reports that come with the Group Benefits Module: 

• Group Business Policy List Report: This report lists all inforce group policies for all 
insurance types for the selected businesses, and has a pie chart option. 

• Group Business Summary Report: This report provides a summary of policy information, 
for one insurance type or multiple insurance types, and has a pie chart option. 

• Group Business Detail Report – Medical: This report provides a summary of the policy and 
premium information for medical policies. 

• Group Business Detail Report – Vision: This report provides a summary of the policy and 
premium information for vision policies. 

• Group Business Detail Report – Dental: This report provides a summary of the policy and 
premium information for dental policies. 

• Benefits Report: This report lists all benefit information for one or multiple insurance types. 

All Group Policy Reports can be sorted by effective or renewal dates for any date range. All 
reports have customizable headers, footers and disclaimers. 
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Running Group Policy Reports 
To run a Group Policy report, open the Business window, click the Reports menu, point to 
Group Policy Reports, and then click the name of the report on the submenu. 

When the Group Policy Report Setup dialog box opens, select the options and date range, edit the 
header and footer text as needed, and then click OK. (Refer to the Appendix for field 
descriptions.) 

 
Benefits Report 
The Benefits report has additional setup options that control the insurance types and plan benefits 
that are included in the report. After clicking OK in the Group Policy Report Setup dialog box, 
the Enter Parameters Value dialog box will open. Select an insurance type from the drop-down 
list in the Discrete Value field and then click Add. Repeat this procedure to add other insurance 
types to the Value list and then click OK to generate the report. 
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Appendix 
Medical Benefit Tab Fields 
Category:  This read-only field automatically indicates the name of the medical 

benefit tab where the policy option is located. 

Options: This read-only field automatically indicates the name of the benefit 
option that is being modified. 

In Network:  Use this field to indicate the benefit provided when using physicians or 
medical facilities that are part of a provider network. 

Out of Network:  Use this field to indicate the benefit provided when physicians or 
medical facilities are used that are not part of a provider network. 

Special/Other:  Use this field for additional rates or other stipulations for the benefit 
option. 

Business Detail Tab Fields 
TaxID:  Use this field to enter the Tax ID number for the business. 

Type/Sub Type:  These fields can be used to categorize the business record. Data in 
these fields can be used as record search criteria. 

Source/Sub:  Enter the source of the business record in these fields. Data in these 
fields can be used as record search criteria. 

SIC: Use this field for the 4-digit Standard Industrial Classification number. 

Industry:  Use this field to further classify the industry for this business. 

Employees:  This field automatically indicates the total number of employees in the 
group census. 

Revenue:  Use this field for the approximate gross revenue of this business. 

Class:  Use this field to further classify the business (i.e., Company, 
Partnership, Trust, etc.). 

Potential:  Use these fields for the estimated revenue potential of the business and 
the date of that estimate. 

Stage:  This field is intended for use with the CDS Wave Auto Action feature. 

AlphaKey:  This is a customizable field for alphanumeric data (letters & numbers). 
Changes in the field name will appear in Find Business dialog box. 

Group Census Record Fields 
Contact:  This field indicates the name of the Contact that is linked to the Group 

Census record. 

Key Employee:  Use this field to indicate whether this employee is considered a key 
part of the organization. This can be useful for individual business 
marketing campaigns. 

Hire Date:  Use this field for the hire date of the employee. 
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Class:  Use this field to categorize the employee (i.e., managers, executives, 
other, etc.). 

Compensation:  Use this field for the employee’s annual income. 

Alphanum1:  This is a customizable field for alphanumeric data. 

Alphanum2:  This is a customizable field for alphanumeric data. 

Cobra Beg/End:  Use these fields for the beginning and ending dates that may apply to 
COBRA benefits for the employee. 

Pre.Ex.Cond:  Use this field for any pre-existing medical condition that the employee 
has. 

Policy Information Tab Fields 
Business Name:  Use this field for the name of the Business that is linked to the group 

policy. 

Carrier:  Use this field for the name of the insurance company that carries the 
group product.  

Product:  Use this field for the name of the group.  

Policy #:  Use this field for the group policy number. 

Status:  Use this field for the current status of the group policy (e.g., inforce, 
pending, terminated, etc.). 

Effective Date:  Use this field to assign an effective date for the policy. 

As of Date:  Use this field to track policy information updates. 

Renewal Date:  Use this field for the date that the group policy must be renewed by for 
coverage to continue without interruption. 

Modal Premium/Mode:  Use these fields for the calculated Modal Premium and Mode 
(monthly, quarterly, etc.). 

Annual Premium:  This field is automatically updated, based on information in the Modal 
Premium and Mode fields. 

Primary Agent:  Use this field to link the primary agent’s record to the group policy.  

Initial Rate:  Use this field to indicate the portion of premium that must be paid at 
the time the policy goes into effect. 

Rate Guarantee: Use this field to indicate the period of time that the premium will not 
change, regardless of claims history. 

# of Members:  Use this field for the total number of employees enrolled in the group 
policy plans. This number can be entered manually, or use the 
Calculate button to update this field. 

Probation Period:  Use this field to indicate the period of time that employees must wait 
before they are eligible for group insurance benefits.  

Termination Date:  Use this field to indicate the period of time that policy benefits remain 
in effect after employment termination. 

Minimum Hours:  Use this field to indicate the minimum number of hours an employee 
must work to be eligible for policy benefits. 
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ER Contribution:  Use this field to indicate the amount of the employer’s contribution to 
a contributory plan. 

Participation %:  Use this field to indicate the percent of employee participation. 

Salary Updates: Use this field to indicate the update frequency for employee salary 
information. 

Plan Design:  Use this field for plan designs (e.g., HMO, PPO, etc.). 

Last Modification:  This field is automatically updated when the policy or plan information 
is changed. 

Premium Tab Fields (Medical, Dental & Vision) 
ER Cost:  Use this field for the employer’s cost for the appropriate rate. 

EE Cost:  Use this field for the employee’s cost for the appropriate rate. 

Participation:  Use this field for the number of current participants at each rate. 

Total:  These read-only fields indicate the totals for each column after 
multiplying EE Cost and ER Cost by the numbers in the Participation 
column. 

Custom Tab Fields 
Date: User-definable fields for tracking important dates related to the 

product. 

Numeric: User-definable fields for tracking important numbers related to the 
product. 

AlphaNumeric:  User-definable fields for tracking virtually any type of information 
related to the product. 

YesNo:  User-definable fields for tracking included/excluded items or features 
related to the product. 

Remarks:  Use this field for notations about the product. 

Group Policy Report Setup 
ReportBy:   Select By Effective Date or By Renewal Date from the drop-down list 

to use with the From and Thru date fields. Leave this field blank to 
include all policies in the report. 

DateFrom:  Specify the beginning date for the report. Leave this field blank to list 
all policies. 

DateThru:  Specify the ending date for the report. Leave this field blank to list all 
policies.  

GraphChart:  Select this check box if to include a pie chart at the end of the report. 

Disclaimer:  Select exiting disclaimers, or click the field name button to add or 
modify disclaimer that will be printed at the bottom of the report. 

Header:  The text in this field can be edited and will display as the heading for 
the report. 

Footer:  The text in this field can be edited and will display at the bottom of the 
report. 
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